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1. Introduction/background: 
 
Ship’s lines are  generally  designed  to be  “fair.”  To the naval architect, fairness means that the  
lines have  a  continuous second derivative; this is the definition of a spli ne. Before the advent of 
digital computers, naval architects checked every  line on a lines plan for fairness by bending a  
thin stick of wood, called a batten, on the line. If the line followed the natural bend of the batten, 
the line was fair. This phenomenon follows from the beam equation, which shows that the 
minimum energy in  a  beam with given boundary  conditions and passing through given points 
occurs when the beam has a continuous second derivative of position.  
 
Typically designers will start with an existing ship, referred to as a “parent hull,” to develop a 
new ship’s geometry  and  will use “design lanes”  for various ship characteristics and  coefficients 
as a “final sanity  check”  of new hull  form designs.  We will visit some of  those design lanes  in 
this project.  
 
In lieu of drawing the ship’s lines, we will generate a conventional destroyer type hull by  
specifying several primary  ship characteristics and coefficients. Various computer aided ship 
design tools  can be used  to develop a hull.  For this assignment we will use a computer aided 
design tool used by the U.S. Navy: the Advanced Surface Ship and Submarine Evaluation Tool  
(ASSET).  
 

   
   

  

Computers with ASSET version 6.3 software loaded are available to you in the 2N Ship Design 
Lab. ASSET 6.3 is under All Programs > LEAPS > Applications > ASSET 6.3.0.  An older 
version, 5.3, is under >All Programs >ASSET. Make sure you are using ASSET 6.3 and not the 
older version!  
 
ASSET 6.3 Training  Files are located on the design lab computers under \\CADFAC\2n design 
lab share drive\ASSET Training  Files.  
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2. Assignment:  
 
Using ASSET 6.3, each student will generate a baseline  hull based on a  given set of ship 
characteristics and form coefficients.   
 
Each student will then  perform a controlled  variant study by changing one  characteristic or  form 
coefficient at a time  and inspecting the results.  
 
Next, each student will determine/calculate  the ship’s characteristics and form coefficients at the  
Design Waterline (DWL) and compare computer generated results to hand calculations for  
waterplane areas.  
 
3. Procedure/Deliverables:  
 
ASSET 6.3 is relatively new and somewhat “buggy.” It is not uncommon for it to freeze or crash. 
Save your work often!  If the program freezes and you have to force it to close, you may not be  
able to reopen your databank because it contains a “lock file.” Simply go into the folder where  
your databank is, find the lock file and delete it. Then you should be able to reopen your 
databank.  Feel free to contact the TA or the professor for advice.  
 
3.1 Creating a Baseline Hull  
 
First you need to copy  reference ASSET databank to your profile. The reference databank is 
provided to us by NSWCCD and contains parent hulls of several different types of navy ships. 
From the recitation folder, copy the folder ASSET63RefDB  to your profile. DO NOT MODIFY 
THE ORIGINAL DATA BANKS ON THE  LAB  COMPUTERS! Inside this folder will be  your 
databank, ASS ET63RefDB.pdbIndex,  along with several other files. This is now YOUR data 
bank for this and future projects. Second, perform the same procedure  with the  
HullformLibrariesV63 folder as both will be required for this and  future projects.  
 
Open ASS ET 6.3  by double-clicking the desktop icon. You will be prompted  to “Select 
DataBank.”   Choose  the file “ASSET63RefDB.pdbIndex” from your copy  of the data bank 
folder  on your desktop.  The  Messages window at the top  in ASSET should indicate that the  
databank was opened.  Change to English units under the Options menu (this must be done every  
time you open ASSET). Select the icon, , “ Open Current Model from Databank.”  Select 
“Destroyer-Mech” from the list (the “Destroyer”  model has an electric propulsion system while  
the “Destroyer-Mech” model has a traditional mechanical propulsion system).  
 
Now  you will generate your baseline hullform. In the “Surface Combatant Module Run 
Manager”, double-click “Hullform Utility.”   
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Once the application window opens, click on  the Open Existing Database icon, , and open 
your  “HullformLibrariesV63.pdbIndex” file.  Next you will select a parent hullform, select the  
“HFT_DDG79_wsd” hullform and click OK.  This is a model of a U.S. Navy  destroyer; “wsd”  
means “with sonar dome.”  
 
Once the hullform is opened, click the “Shaper” tab. At this point in the project, you will need to 
balance  your design. The goal is to create a hullform with the following parameters:  
 

LBP   = 450 ft     Cp = 0.60  
B = 60 ft     Cx = 0.83  

  T = 20 ft       D10 = 37 ft  
 

(Ensure values are within 0.5% tolerance)  
 
Once  you have balanced the parameters above, export the hullform into ASSET 6.3 by clicking 

 in the upper right corner.  Click OK to any  following windows acknowledging combining  
or converging  certain features. Then, select NO step to be added and go ahead and Start the  
transfer.  If you come across any messages that require the hullform to converge, select OK.  
 
Once the transfer is  complete, Save the Model As in the File menu as the name “Baseline.”  Now  
that you are back at the  main ASSET window, click the Toggle Model Editor icon,  to enter 
editor mode. Enter  the values in Table 1. You can use the find function (the binoculars icon) to 
search for the parameters. As you enter the data, right-click on the parameter names and read 
their definitions. Think about what effect each parameter might have  on the design.  A list of the  
organizational tree structure is in the Appendix.  
 
DO NOT  change any values in the “Hull Form  Parent Controls” section.  If one of your 
searches winds up in the parent section  where the  parameter names are preceded by  “Ps,”  use the  
“find next” function to find the same parameter in the current ship sections.  
 
1)  Derived  Aviation  Facilities  Indicator  = MINOR AVN  10)  Main  Deck  Height =  37.0  FT  
2)  Derived  Embarked  Commander  Indicator  = NONE  11)  Hull Offsets  Indicator  = GIVEN  
3)  Design  Mode Indicator  = SHIP  WT  12)  Hull Dimensions  Indicator  = NONE  
4)  Design  Endurance  Displacement Indicator  = FULL  LOAD  13)  Bulwark  Height =  0  FT  
5)  Design  Endurance  Definition  Indicator  = USN  14)  Bilge Keel Indicator  = NONE  
6)  Design  Sustained  Speed  Indicator  = CALC  15)  Skeg  Indicator  = PRESENT  (given  in  hullform)  
7)  Design  Endurance  Speed  Indicator  = GIVEN  16)  Boundary  Conditions  Indicator  = GIVEN  
8)  Design  Endurance  Speed  = 15  KTS  17)  Hull Station  Indicator  = OPTIMUM  
9)  Ship  Type Description  = SC   

Table 1: Common  Parameters  

The following parameters were set in the Hullform Utility  and will not need to be adjusted here. 
Note that in ASSET, a blank cell is not the same as 0:  
 
LBP  (Hull  Length Between Perpendiculars): 450 ft          T (Hull Design Waterline Draft): 20 ft  
B (Hull Design Waterline Beam): 60  ft                                Cp  (Hull Prismatic Coefficient): 0.60  
D10  (Hull Depth at Station 10): 37 ft                     Cx  (Hull Maximum Section Coefficient):  0.83  
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Next, calculate and input the Weight at Full  Load  (Ship Char  > General Char > Principal Char)  
using the following formula (do you understand why this works?):  
 

                !        
       

 
  

         ⁄⁄    !   
 
Click the Toggle Model Editor icon  to exit the editor. This will take  you back to the Module Run 
Manager window. Answer YES when asked if you want to store modifications to the current 
model.  
 
Now  (and frequently hereafter)  you should save  your  model; click File > Save Model  
 

Allow ASSET to synthesize  (converge) your model by  clicking  , Toggle Synthesis Manager,  
button and then double-clicking “Surface Combatant Synthesis” in the left pane. When it is done, 
you will see  a  Design Summary Report in the Synthesis Manager window. For purposes of this  

project, we  are only interested in the  hull geometry. So click , the  Module Run Manager 
window, a nd double-click “Hull Geometry Module.”  You will see  a summary of the  geometry  
parameters and calculated values. Make sure  you understand what they  all mean. Look them up 
in the Help files if you need to.  
 
Double-click on Body Plan, Hull  Isometric Plan, and the other graphics to see  your ship’s lines.  
 
Verify  your displacement by checking the value of BARE HULL  DISPL  on DWL  in the  “Hull 
Geometry Report”  and comparing it to your input (hand-calculated) value.  If it matches within 
0.5%, you are  good to go…if not, verify  your inputs from Table 1. Another  check is to open 
Hullform Utility  and verify the displacement calculated for  you but understand that the principal 
dimensions coming out of Hullform Utility are inexact values. Anothe r reason for the values to 
be different is that ASSET treats appendages as part of  your hand-calculated value. You 
accounted for this in Table 1 but the hand-calculated value is the displacement of the molded 
volume.  
 
Deliverable D-1:  “Hull Geometry Report,”  “Body  Plan,”  and “Hull Isometric View.”  
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3.2  Variant Creation  
 
Use ASSET with the parameters given in Table 2  below to generate your hull variants. Don’t 
forget to recalculate and re-input  your full load weight. SAVE these  ships  in  your databank 
individually!  
 

 
Variant  LBP(ft)  Cp  Cx  
Baseline  450  0.60  0.83  

1A  475  0.60  0.83  
1B  425  0.60  0.83  
2A  450  0.56  0.83  
2B  450  0.64  0.83  
3A  450  0.60  0.78  
3B  450  0.60  0.88  

Table 2: Variant Parameters  

 
D-2:  Perform a comparative analysis of your baseline hull and six variants using the  above  
characteristics and form  coefficients in Table 2.  Are there any  evident relationships and/or 
conclusions that you can derive/detect?   Comment on how the various parameters affect the lines 
and the displacement. Which parameter has the greatest impact on GMT?   On AWS?  etc.  
 

Variant  Δ  KB  BMT  CWP  AWS   GMT  
Baseline        

1A        
1B        
2A        
2B        
3A        
3B        

Table 3: Comparative  Analysis  
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3.3 Methods of Numerical Integration  
 
There  are two numerical integration techniques that you will conduct to calculate the waterplane  
area  at a specific waterline. The ship’s stations are  generated automatically  according to the  
selected option  in ASSET, OPTIMUM, in order to create an optimal numerical model of the  
hullform. This part of the project  checks  those calculations with Simpson’s rule and the 
trapezoidal rule.  
 
D-3:  For the Design Waterline (T=20  ft) determine/calculate the following hull form 
characteristics and form coefficients  using the information from the ASSET  Hull Geometry  
reports for  the Baseline hull:  

 
 Δ   CB   L/B  
 LBP   CP   L/T  
 B   CWP   B/T  
 T   CM   UwVol /(L/10)**3  
 Underwater Vol   CX   Δ  / (L/100)**3  
 AWP   CIL   LCB  
 AM   CIT   KB  
 AX      
 
D-4:   A sectional area curve for  your ship, “Hull Sectional Area Curve Graph.”  
 
This next section requires understanding the Simpson’s and trapezoidal rules  (Appendix B in 
Gillmer and Johnson). Since, they require  an “x” value (station location) and “y” value (half 
breadth/beam), you must pull these values from the Hull Offsets report in the Hull Geometry  
Module. You should notice that the section spacing isn’t uniform; therefore, you must interpolate 
the “y” values based on evenly spaced stations that you specify. The  same  procedure for  
waterplane areas (AWP) applies to calculating sectional areas (AM) with exception of the 
reference value. For  example, given the data below; find the “y” value  at station location, x=  -10 
ft for a 40 ft waterline.  

STATION NO. 6, AT X = -10.328 FT  

POINT  HALF BEAM,FT   WATERLINE,FT  

1         0.000        38.832  

2         0.735        40.019  

3         1.484        41.184  

4         3.029        43.493  

5         4.583        45.789  

STATION NO. 7, AT X = -8.834 FT   
POINT  HALF BEAM,FT   WATERLINE,FT   

1         0.000        37.303   
2         0.751        38.668   
3         1.521        40.001   
4         3.331        42.888   
5         5.185        45.706   

 
Answer: y =  0.908 ft (half beam)  
 
Refer to Appendix for interpolation help.  
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D-5:  By “hand”, using  Simpson’s  rule  and the offsets  ASSET calculated, calculate the following  
characteristics and form coefficients at the DWL (T=20  ft) and compare  your results to those 
generated by ASSET  (note: ASSET does not provide a value for LCF).  Explain any significant 
(> 5%) differences.  
 

 AWP   CWP   
 AM   CM   
 LCF   CIL   
   CIT  
    

D-6:  Recalculate AM   using  the trapezoidal rule and comment  on your results.  
 
D-7:  Conclusions and Recommendations  
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4.   Appendix:  
 
4.2  Calculating Hullform  Coefficients and Parameters  

 It may be useful to note that, according to Gillmer and Johnson,  
   
          ̅̅̅  ̅̅̅!̅̅̅̅̅      

 
and  

 
            ̅̅̅  ̅̅̅!̅̅̅ ̅  
 
You can’t use the ASSET-generated offsets to “hand” calculate the section area  at midships 
with Simpson’s rule, because the waterline spacing is not uniform. You can use  your 
interpolated values at the "round number” waterlines, but to get sufficient accuracy, you will  
need greater  resolution that the 2 ft waterline intervals in the table.  

 
4.3 ASSET Tree to Find Parameters  
 
Ship Requirements > Derived Requirements >  Derived Mission Requirements >  Derived 
Facilities  
 
  1 - Derived Aviation Facilities Indicator – M INOR AVN  
  2 - Derived Embarked Commander Indicator  – N ONE  
 
Ship Requirements > Derived Requirements > Design Endurance  
 
  3 - Design Mode  Indicator  – S hip WT  
  4 - Design Endurance Displacement Indicator – F ull  Load  
  5 - Design Endurance Definition Indicator –  USN  
 
Ship Requirements > Derived Requirements > Design Speeds  
 
  6 - Design Sustained Speed Indicator –  CALC  
  7 – De sign Endurance Speed Indicator – G IVEN  
  8 – De sign Endurance Speed = 15 kts  
 
Ship Characteristics > General Characteristics  
 
  9 – S hip Type Description  –  SC  
 
Ship Geometry  > Molded Form Views > View of Decks >  Hull Decks  
 
  10 – Main D eck Height – 37 ft   
 
Ship Geometry  > Molded Form Views > View of Hulls > Hull 0000001 > Hull Form Factors  
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  11 – H ull Offsets  Indicator - GIVEN   
  12 – Hull Dim ensions Indicator - NONE   
  13 – B ulwark Height – 0   ft   
 
Ship Geometry  > Molded Form Views > View of Hulls > Hull 0000001 > Hull Shell Appendage  
 
  14 – B  ilge Keel Indicator  –  NONE   
  15 – S  keg  Indicator – P RESENT (given in hullform)   
 
Ship Geometry  > Molded Form Views > View of Hulls > Hull 0000001 > Hull Boundary Cond.  
 
  16 – B  oundary Conditions Indicator – G IVEN   
  17 – Hull S  tation Indicator  - OPTIMUM   
 
 
4.4 Interpolation:  
 

 
 

 
𝑦! =

! ! ! !

(𝑥! − 𝑥!)
+ 𝑦!	  
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𝑥 − 𝑥 (𝑦 − 𝑦 )

To	  interpolate	  the	  𝑦!	  value:	  
𝑥!, 𝑥!,𝑦!	  	  and	  𝑦!	  need	  to	  be	  entered/copied	  from	  the	  table.	  

𝑥!	  defines	  the	  point	  to	  perform	  the	  interpolation.	  
𝑦!	  is	  the	  interpolated	  value	  and	  solution	  

	  
𝑥!	   𝑦!	  

𝑥!	   𝑦!	  

𝑥!	   𝑦!	  
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